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1.1 How to use this guide 

This guide is designed to assist you to upgrade your current installation or set up a new 

installation of Sage X3 Intelligence Reporting. This guide relates to the version 7.6.1 release 

of Intelligence Reporting.  

This guide provides the information you need to: 

 Install or upgrade Sage X3 Intelligence Reporting.  

 License Sage X3 Intelligence Reporting.  

 

The order of topics in this guide matches the sequence of tasks you would typically perform 

to install and set up Intelligence Reporting. 

We assume that you: 

 Have completed Sage X3 installation and setup.  

 Have experience working with Sage X3. 

 

Note:  This guide contains troubleshooting tips and technical information on configuring 

supported accounting systems and database engines for use with Intelligence Reporting. 

However, this guide is not a replacement for a qualified network or database 

administrator. 

 

1.0 Introduction 
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2.1 System Requirements  

Before you can install Intelligence Reporting on a workstation or server ensure that your 

hardware and software meets at least the recommended system requirements and that you 

have the necessary prerequisites installed. 

2.1.1 Recommended System Requirements 

One of the following operating systems fully installed and operational:  

 Windows 7 (32 and 64 bit)  

 Windows 8 (32 and 64 bit)  

 Windows Server 2008  

 Windows Server 2012  

 Windows Terminal Server  

 Ensure Sage X3, is fully installed and operational. For a complete guide on installing 

Sage X3, please refer to the Sage X3 Installation Guide. 

 

Note: You do not need to have Sage X3 installed on the same workstation, however, the 

workstation will need to be able to access to the Sage X3 SQL database. 

 Microsoft .Net Framework 4.0 (This will be installed upon installation of Intelligence 

Reporting if it is not present).  

 Microsoft Excel 2007 or higher. Open Microsoft Excel at least once to ensure that it is 

fully licensed and activated before installing Sage Intelligence Reporting. Close Microsoft 

Excel before beginning the installation.  

 Hardware: CPU > 1.3 GHz  

 Memory: 4GB RAM  

 Hard Drive Space: 350 MB 

 

2.1.2 Database Connectivity Supported 

Intelligence Reporting uses ODBC and OLEDB technology to gain access to Open Database 

Systems. Intelligence Reporting includes direct support for most popular database systems 

and Connection Types which are included within the Connector. For systems where a 

Connection Type does not exist but where the system has an ODBC driver these can be 

accessed via the System DSN connection types within the Connector. 

 

2.0 Getting Started 
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The Sage X3 database type supported is: 

 Microsoft SQL Server  

 

Tip: Although the standard Intelligence Reporting report layouts are for Microsoft SQL 

databases only, Intelligence Reporting will allow the user to connect to Oracle databases 

as the software supports any ODBC connection. Once you have set up this connection in 

the Connector, you will be able to create containers and reports based on data stored in 

your Sage X3 Oracle database. 
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3.1 Installing the Software 

Intelligence Reporting must be installed on all workstations on which the software will be 

used. The following steps should be followed if you are installing Intelligence Reporting for 

the first time. If you already have a previous version of Intelligence Reporting installed and 

wish to upgrade to the latest version of the software, please refer to the section on upgrading 

the software. 

Before installing Intelligence Reporting please ensure that you have familiarized yourself 

with the system requirements. 

1. Download Sage X3 Intelligence Reporting version from the Sage Intelligence website 

www.sageintelligence.com  

2. Save the Sage X3 Intelligence Reporting.exe file to your local machine or network.  

3. Ensure that all instances of Microsoft Excel are closed.  

4. Run the Sage X3 Intelligence Reporting.exe file. You will need Microsoft Visual Studio 

Tools for Office runtime to be installed. Click on Install. 

 

5. The Install Wizard will appear. Click on Install. 

3.0 Installing Intelligence Reporting 

http://www.sageintelligence.com/
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Note: Intelligence Reporting requires the Microsoft.NET 4.0 Framework and you will be 

prompted to install this if it is not already installed.  

6. Select Next to install to the default Installation destination location C:\Sage Intelligence\. 

Select Change to change the default Installation destination location. 
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7. When prompted to choose a location, ensure that you select the correct region and then 

select Next.  

 

Note: Sage X3 Intelligence Reporting will run on a 30-day Free Trial licence that has no 

limitations. Once this licence has expired you will need to register your software.  Please 

refer to Licencing Intelligence Reporting for more information on how to licence your 

software. 

  



 

 

Sage X3 Intelligence Reporting Page 10 of 41 
 

 

8. Select Install.  

 

9. After installation is complete, you will be prompted to create a new Sage X3 SQL 

database user to use when logging in to Intelligence Reporting. This automates the 

process of manually creating a Sage X3 database user as described in the section 

“Creating a Sage X3 SQL database user”. Select Next to continue or Finish to exit the 

SQL User Creation Tool and complete the installation.  
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10. Enter the SQL Server and the existing SQL database username and password to 

connect to the specified SQL server. Select Connect.  

 

Note: A Start Menu shortcut will be created to allow you to launch the SQL User Creation 

Tool at a later stage should you wish to create a new SQL database user after installation 

has been completed, for example to the SEED schema for demonstration reports. 
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11. On the left, select the Sage X3 database which you wish to report on. This will be the 

database and schema your company data is found on. On the right, select the relevant 

schema for the selected database. The user created will have the selected schema 

assigned as the default schema. For example, to view my company data, I will might 

need to connect to the x3v7 database and the X3 schema as shown below. Click Next. 

  

 

12. Enter the new username and password. Click Create. 
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13. The new user is created. Click OK. Once back in the InstallShield Wizard screen click 

Close to close the SQL User Creation Tool. 

 

 

14. You have successfully installed the software. Click Finish. 
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3.2 Upgrading the Software  

Intelligence Reporting must be installed on all workstations on which the software will be 

used. The following steps should be followed if you are upgrading from a previous version of 

Intelligence Reporting. 

1. Download Sage X3 Intelligence Reporting version from the Sage Intelligence website 

www.sageintelligence.com 

2. Save the Sage X3 Intelligence Reporting.exe file to your local machine or network.  

3. Ensure that all instances of Microsoft Excel are closed.  

4. Ensure all instances of your existing Intelligence Reporting software have been closed.  

Note: You do not need to uninstall your existing Intelligence Reporting software before 

installing the later version. 

5. Run the Sage X3 Intelligence Reporting.exe file. You will need Microsoft Visual Studio 

Tools for Office runtime to be installed. Click on Install.  
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6. The Install Wizard will appear. Click on Install.  

 

Note: Intelligence Reporting requires the Microsoft.NET 4.0 Framework and you will be 

prompted to install this if it is not already installed.  

7. Select Next to install to the default Installation destination location C:\Sage Intelligence\. 

Select Change to change the default Installation destination location.  
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8. When prompted to choose a location, ensure that you select the correct region and then 

select Next. Ensure you select the same region as you selected on first install.  

 

Note: Sage X3 Intelligence Reporting will preserve your existing licencing information 

upon upgrade.  Once this licence has expired you will need to register your software 

again. Please refer to Licencing Intelligence Reporting for more information on how to 

licence your software.  

9. Select Install.  
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10. After installation is complete, you will be prompted to create a new Sage X3 SQL 

database user to use when logging in to Intelligence Reporting. This automates the 

process of manually creating a Sage X3 database user as described in the section 

“Creating a Sage X3 SQL database user”. Select Next to continue or Finish to exit the 

SQL User Creation Tool and complete the installation.  

 

Note: A Start Menu shortcut will be created to allow you to launch the SQL User Creation 

Tool at a later stage should you wish to create a new SQL database user after installation 

has been completed.   

11. Enter the SQL Server and the existing SQL database username and password to 

connect to the specified SQL server. Select Connect.  
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Note: A Start Menu shortcut will be created to allow you to launch the SQL User Creation 

Tool at a later stage should you wish to create a new SQL database user after installation 

has been completed, for example to the SEED schema for demonstration reports. 

12. On the left, select the Sage X3 database which you wish to report on. This will be the 

database and schema your company data is found on. On the right, select the relevant 

schema for the selected database. The user created will have the selected schema 

assigned as the default schema. For example, to view my company data, I will might 

need to connect to the x3v7 database and the X3 schema as shown below. Click Next.  

 

13. Ensure the default username and password is correct as was used in your previous 

version. If correct, click Close and proceed to step 15.  Should you wish to create new 

details, enter a new username and password and click Create. 
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14. The new user is created. Click OK. Once back in the InstallShield Wizard screen click 

Close to close the SQL User Creation Tool. 

 

15. You have successfully installed the software. Click Finish. 

 

3.3 Retrieving the Latest Report Templates when Upgrading 

Once you have upgraded to the newer version of Intelligence Reporting you can use the 

Bulk Import feature to retrieve the latest Report Templates. You will need to use the latest 

Report Designer Report in order to make use of the latest features. 

1. Select the Windows Start button and search for Report Manager.  
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2. Enter the Sage X3 SQL server, database details and the username and password that 

exist in SQL Server.  These are the details you created on installation for the schema you 

wish to run your reports on e.g. the details used when setting up your company schema 

as the default on installation. 

Note: In order to run the demonstration report the user specified must have the default 

schema set to SEED. To change the default schema please refer to the section Managing 

Access to Sage X3 Data. 

 

3. Tick the Remember Database Credentials box and click OK.  

 

Note: The Report Repository tab contains the default location for the Repository Folder.  

The folder selected does not need to be updated but you are able to select a different 

folder should you need to. When upgrading, new reports will just be added to the default 

location selected and will not override existing reports.   

 

4. The Report Manager module will launch.  

5. Select the Home node in the tree view.  

6. Select the Tools tab and then select Bulk Import.  
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7. Select Yes to continue with importing new reports.  

8. The Bulk Import of new Report will take place and notify you once completed.  

9. Click OK.  

 

10. Double-click on the Home node in the tree view. A new folder named Designer will be 

available containing the new reports. 
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4.1 Entering License Information  

The following steps continue from the preceding section, 1.0 Installing Intelligence 

Reporting. To obtain your license information: 

1. North America – Contact your Sales Representative or Sage Business Partner  

2. Rest of the World – Contact Sage Intelligence Support  

Note: The Report Manager and Report Viewer programs are available with a 30 day free 

trial licence.  

3. Launch the Sage Intelligence License Manager, select the Licenses tab.  

4. Enter your company name and serial number in the properties section. It is 

recommended to copy this information and paste it into the relevant fields in the License 

Manager to avoid spelling and typing errors.  

 

5. Select to perform serialization and once serialization is complete you will receive a 

confirmation message.  

 
  

4.0 Licensing Intelligence Reporting  

mailto:support@alchemex.com?subject=Sage%20Intelligence%20Financial%20Reporting%20for%20Sage%20ERP%20X3%20Controlled%20Release%20-%20License%20Information
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6. The available licenses associated with your serial number will display in the License 

Manager.  

7. Close the License Manger and proceed to launch a licensed Intelligence Reporting 

module.   

Note: The region selected when installing the software will determine how your serial 

number is authenticated. It is important to ensure that the correct region is selected upon 

installation to ensure successful registration based on your geographic location. 



 

 

Sage X3 Intelligence Reporting Page 24 of 41 
 

 

The MetaData Repository stores all of your important information including connection, 

container, report information and reporting trees in one folder. 

5.1 The Benefits of the MetaData Repository  

Sharing the MetaData Repository folder allows report templates to be accessed by multiple 

users. 

By storing all of your important information in one folder, backing up this folder will ensure 

that all of your connection, container, reporting trees and report templates can be easily 

restored in the event of data loss. 

5.2 Locating your MetaData Repository  

During installation, the Sage Intelligence Reporting MetaData Repository is created by 

default in a folder named Metadata in the location 

C:\ProgramData\Alchemex\AlchemexForSage ERPX3\. 

Tip: It is recommended that you change the default MetaData location to a shared 

network location so that you will be able to share your report templates with other 

Intelligence Reporting users. In order for users to access the MetaData on a network 

location they will need full access rights to the network folder. 

8. The location of your MetaData Repository can be found by opening the Report Manager 

or Connector. In the window that opens, on the Report Repository tab, your MetaData 

Repository location will be displayed. 

 

 

Tip: Add this folder to your daily backups to ensure that all of your connection, container, 

reporting trees and report templates can be easily restored in the event of data loss. 

5.3 Allowing Report Templates to be Accessed by Multiple Users  

By using a shared MetaData Repository, multiple users can access report templates. You 

can use a shared metadata repository by following the instructions in the Installation section. 

5.0 The MetaData Repository 
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6.1 Managing User Security  

6.1.1 The Security Manager 

The Security Manager is an administration tool that lets an administrator manage roles (user 

groups) and assign users and reports to each role. When security is enabled the user will be 

required to login and then will only have access to the reports selected for the role that the 

user belongs to. The Security Manager ensures that access to important or sensitive reports 

is securely controlled. The Security Manager does not limit access to Sage X3 data. 

Tip: It is highly recommended that security be enabled to prevent unauthorized user 

access into the Security Manager. 

The following rules apply: 

 Report level security will by default be switched off at installation and must be switched 

on within Security Manager to take effect.  

 Only users added to the Administrators role will be allowed to Add/Edit/Delete reports 

within the Report Manager.  

 The list of users within the Security Manager are not synchronized from the Sage X3 

user list and you will be required to create users within the Security Manager.  

 

The Security Manager allows you to: 

 Set security on or off.  

 Manage roles.  

 Manage users.  

 Select which users belong to which roles.  

 Select which reports belong to which roles.  

 Select which roles can edit reports.  

 
  

6.0 Setting up User Access  
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6.1.2 Activating the Security Manager 

It is highly recommended that security be enabled to prevent unauthorized user access into 

the Security Manager. 

1. Open the Security Manager using the credentials to assess your company schema.    

 

2. Click the Security On checkbox to enable it.  
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3. You will be prompted for a password. Type in a password and click Set.  

 

4. Confirm your password. This password will be required in future to gain access to the 

Security Manager.  

 

5. Click OK. A confirmation window will appear.  

6. Click OK.  

 

6.1.3 Adding Roles 

7. From the Users tab, click Add under the Roles pane to add a new role.  
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8. Enter a name for the Role.  

 

9. Your role will now be added.  

 

6.1.4 Adding Reports to Roles 

1. Click on the Reports tab to assign access to specific reports for each role.  

 

 

2. Ensure the correct role is selected in the left pane, then select the reports in the right 

pane which that role must have access to.  

Note: Union/sub reports are automatically added when the main report is added. 
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3. The users now assigned to that role, have access to the reports that the system 

administrator has assigned to the role.  

 

6.1.5 Allow Report in this Role to be edited 

 

If you have Security enabled in Security Manager, you are able to assign rights to Roles 

pertaining to the users and the reports these users have the rights to run.  Assigning these 

rights means that even if the user has a Designer Licence, they are not able to edit the 

report in question, just run the report.  

Should this user however be required to edit the report template and not just run the report 

out of Report Manager, the role the user is assigned to in Security Manager needs to be 

assigned the right to edit the report. This can be done in Security Manager under the 

Functions tab in the applicable role. 
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6.2 Managing Access to Sage X3 Data  

6.2.1 Creating a Sage X3 SQL database user 

In order to access the Sage X3 SQL data Intelligence Reporting requires the SQL database 

server and user credentials. Limiting access to Sage X3 data must be managed using SQL 

database user security. 

The SQL database user needs to be a db_reader and attached to the relevant schema so 

that Intelligence Reporting can read the relevant database. If using OLAP (Analysis module) 

functionality in conjunction with date dimension table creation, the SQL database user will 

need to be edited to have read-write access to write to the date dimension table. 

To set up a SQL database user for your Sage X3 database you can either use the SQL User 

Creation Tool installed with Intelligence Reporting to create a new user or you can follow the 

steps detailed below to manually create a user or modify the settings of an existing user. 

Tip: The SQL User Creation Tool is installed with Intelligence Reporting and can be 

launched from the Start Menu. 

 

To manually create or modify a SQL user: 

1. Select the Windows Start button SQL Server Management Studio. If you do not have 

access to the server(s) on which the Sage X3 data resides, you will need to contact your 

server administrator to complete the following steps.  

 The Connect to Server screen will appear. Enter the SQL Server login details and click 

the Connect button.  

 Server name: enter name of the server you wish to connect to.  

 Authentication: select SQL Server Authentication.  

 Login: your username.  

 Password: your password.  
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2. The Object Explorer screen will open. Expand the Security and Login folders. Right-click 

on the Logins folder and select the New Login… option.  

 

3. The Login - New screen will appear. Enter information and click the OK button.  

 Login name - enter a login name.  

 Select SQL Server authentication and enter passwords in the Password and Confirm 

password boxes.  

 Default database e.g. X3v6data.  
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4. From the Object Explorer expand the Databases and x3v6data folders. Right click on the 

Security folder and select New > User….  

 

 

5. Enter the Username: enter the same name as the Login name.  

6. Enter the Login name: enter the same name as the username.  

7. Enter the default schema: select the relevant schema name from the lookup button. The 

default schema for the Demonstration Report Designer is SEED. 

8. Tick the db_datareader checkbox in the Role Members section. Tick the db_datawriter 

option if using the OLAP functionality.  
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7.1 Overview of Intelligence Reporting Modules 

Intelligence Reporting can give users an open view of their data across several platforms 

and consists of user friendly modules. 

 

The Connector allows access to the information you need from multiple sources 

and consolidation of data from multiple companies. The Connector allows for 

consolidations and connectivity to unlimited ODBC data sources and includes a 

graphical join tool to simplify database queries. 

 

The License Manager manages licenses for each module (Report Manager, 

Connector, Analysis Module, Report Viewer and Report Designer). 

 

The Report Manager allows authoring of new reports from existing data 

containers as well as editing of existing standard reports, including filtering and 

aggregating of data. It also supports auto-emailing of reports, scheduling reports, 

and publishing report output to HTML for intranet/internet. The Report Designer 

expands upon the functionality of the Report Manager to provide simplified drag-

and-drop report creation capabilities allowing you to build impressive reports 

showing critical business analytics that your management teams can use to 

enable insightful decision making at every level. 

 

The Analysis Module is an additional module that functions between the Sage 

Intelligence Reporting Connector Module and the Report Manager module. The 

purpose of the Analysis Module is to use an existing connection to a database 

provided by the Connector to access data and create an offline .cub file. This 

.cub file is then in turn used by the Sage Intelligence Reporting Report Manager 

module to create reports and finally Microsoft Excel is used to browse this cube 

data and create an output that can be linked to Intelligence Reporting and 

refreshed as and when required. 

 

The Report Viewer allows real time running of reports, editing capabilities in 

Excel and offers drill-down functionality on existing reports and templates. 

 The Security Manager defines security for reports and users. 

 The SQL User Creation Tool allows you to create logon credentials for a 

selected database and schema. This tool can be used to create multiple logon 

credentials to the same database and schema if multiple users want to utilise the 

same data set. You can also create logon credentials to additional database and 

schema setups, for example to the SEED schema, allowing you to run reports of 

that dataset.  The credentials used when logging in determines which data set is 

utilised when running the report.   

7.0 Using Intelligence Reporting  
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7.2 Overview of Standard Report Components  

The following components form the basis of simple reporting: 

 A container that defines what data you are reporting from (these are housed in the 

Connector).  

 A report is linked to this container (you can have more than one report per container), 

and reports are housed in the Report Manager. A report defines what fields you want in 

the report and any filters or parameters you would like to apply to the data at the time you 

run the report.  

 An Excel workbook that is linked to a report which defines how you want the data 

displayed.  

 

7.3 Opening the Intelligence Reporting Modules  

1. Select the Windows Start button and search for Report Manager.  

 

2. On the login screen, enter the server, Sage X3 SQL database details and the username 

and password that exist in SQL Server for the default schema you wish to run reports for.  

3. Tick the Remember Database Credentials box.  

 

Note:  In order to run the demonstration report the SQL database user specified must 

have the default schema set to SEED.  

4. Select the Report Repository tab. At this point you can change the default MetaData 

location to a network location should you wish to share your reports over a network.  This 

is only required to be changed on first install. After upgrading, the default location will 

already be set to be the location as found previously.  Reports created in your previous 

installs will be available again once you have upgraded as they will be found in the 

default location of the report repository.  
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5. Once you have selected the location for your Report Repository, click OK.  

 

6. The Report Manager module will launch.  

 

7.4 Running Reports from the Report Manager  

1. Launch the Report Manager  

2. Double-click on the Designer folder to reveal the report(s).  

3. Select the Home tab and then select Run  

 

Note: The Demonstration Report Designer is created for Demonstration data. In order to 

run the demonstration report the SQL database user specified must have the default 

schema set to SEED. The Financial Report Designer is created to run on your Sage X3 

data. 
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4. The Report Parameters dialog will open. Enter the parameters relevant to your data and 

press the OK button.  

 

 

Tip: Use the lookup button to retrieve and select a list of valid parameters for each report 

parameter. 

The Data Out progress box will appear.  

5. The report will open in Excel.  

Tip: For concise and informative “How To” videos to help you get started, please visit the 

Sage Intelligence YouTube Channel. 
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8.1 BI Tools tab missing in Excel  

When opening Excel, the BI Tools tab is missing. 

 

8.1.1 Why does this happen? 

 Excel was left open during the install process.  

 Excel has not being launched and configured since installation. When more than one 

Excel version is installed, one of the installed Excel versions have not been launched or 

configured. These block Sage Intelligence Reporting add-Ins from registering themselves 

due to their dependency on Excel.  

 Incorrect versions of DLL files.  

 Ghost instances of Excel were running in the Task Manager. A ghost process is a 

process which is not terminated when its associated application is closed. This is visible 

in the Task Manager (right-click the task bar and select Start Task Manager).  

 
  

8.0 Troubleshooting  



 

 

Sage X3 Intelligence Reporting Page 38 of 41 
 

 

8.1.2 Solutions 

Prerequisites: 

 Ensure file extensions are visible.  

 Ensure that there are no ghost processes of Excel in the Task Manager.  

 Excel must have been previously launched and activated.  

 

Solution 1 

1. Navigate to C:\Program Files (x86)\Common Files\BIGenerator  

OR  

C:\Program Files\Common Files\BIGenerator on 32 bit machines. 

2. Run the AlchemexPolicy.exe as administrator.  

 

Solution 2 

1. Launch the Command Prompt as administrator.  

2. Type cd C:\Program Files (x86)\Common Files\BIGenerator  

OR  

C:\Program Files\Common Files\BIGenerator on 32 bit machines.  

3. Enter the following command line AlchemexPolicy.exe –EXCEL and Enter. This registers 

the Alchemex application.  

 

Solution 3 

1. If the above does not resolve the issue then navigate to Control Panel > Programs > 

Programs and Features.  

2. Repair all Excel/Office versions installed.  

3. Launch and configure all excel versions.  

4. Close all office applications and ensure no ghost processes are visible in Task Manager.  

5. Locate and select the Sage Intelligence Reporting application in the list of applications 

and click Uninstall/Change.  

6. Repair the software installation. 
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8.2 Report Designer Task Pane is missing or closed 

8.2.1 Why does this happen? 

 The Task Pane is only made available by default to the Windows user who installed it.  

 Excel was left open during the install process.  

 Excel has not being launched and configured since installation. When more than one 

Excel version is installed, one of the installed Excel versions have not been launched or 

activated. These block Sage Intelligence Reporting add-Ins from registering themselves 

due to their dependency on Excel.  

 

Solution 

1. In Microsoft Excel, on the BI Tools tab, click Show Task Pane.  

 

2. Check to see if the Task Pane is now visible. If the Task Pane still does not appear, the 

add-in may be disabled.  

3. In Microsoft Excel, click File > Options.  

4. Select Add-Ins.  

5. Verify if the Task Pane is listed under the Active Application Add-ins.  
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6. If Task Pane is not listed under the Active Application Add-ins, under Manage select 

Disabled Items.  

 

7. Click Go.  

8. If the Task Pane is listed in Disabled Items, select Task Pane and click Enable. Click 

Close. 

OR 

If the Task Pane is not listed in Disabled Items, click Close and continue. 

9. Under Manager, select COM Add-Ins and click Go.  

10. Select Task Pane.  

 

11. Select OK.  

12. Under Manager, select Excel Add-Ins.  

13. Select Go.  
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14. Select Task Pane. (If Task Pane is not visible, select Browse and navigate to C:\Program 

Files (x86)\Common Files\BIExcelFunctions\32bit (or 64 bit depending on your computer) 

and select SageBIExcelfunctions to add it.  

 

15. Select OK. 

 

 

8.3 An unexpected error when running a report for the first time 

8.3.1 How does this happen? 

 When Sage Intelligence Reporting is installed for the first time and the first report is run, 

an error message might pop up to indicate an unexpected error has occurred.  

 

Solution 

1. Select OK in the popup message.  

2. Run the required report again.  The error should not occur again 


